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1 About this Guide
This chapter describes the purpose and scope of this guide, and provides a list of complementary 
guides.

1.1 What this Guide Provides
This guide provides in-depth details about setting up and using the eBUS Player software application to 
control your GigE Vision or USB3 Vision compliant video transmitters (cameras) and receivers.

1.2 Related Guides
eBUS SDK Related Documents

Guides are complemented by the following Pleora Technologies documents, which are available on the 
Pleora Technologies Support Center (supportcenter.pleora.com):

eBUS SDK C++ API Quick Start Guide
This guide provides you with the information you need to install the eBUS SDK (which lets you use the 
eBUS SDK C++ API) and an overview of the system requirements.

Docker Support for eBUS SDK User Guide
This guide provides instruction on how to get started with using eBUS SDK in a Docker environment. 
It also provides basic instruction on how to set up Docker on a Ubuntu-based system. 

Getting Started with eBUS Edge
The eBUS Edge API (introduced in eBUS SDK 6.0) allows developers to create a software-based GigE 
Vision transmitter device. eBUS Edge is fully compliant with GigE Vision and GenICam and will work 
with any GigE Vision and GenICam compliant third-party image processing systems or software.

eBUS Edge on OpenSTLinux (ST Micro MP2 Platform) Quick Start Guide
This guide provides you with the steps to use the eBUS Edge on the ST Micro MP2 Platform running 
OpenSTLinux. This guide is intended for novice Linux users, although advanced Linux users may be 
interested in some of the eBUS SDK-specific elements of this guide for cross-compiling eBUS Edge 
application using eBUS SDK.

eBUS SDK Licensing
This knowledge base article explains the eBUS SDK license structure, explains how to obtain a 
license, and provides activation instructions. If you are experiencing difficulty activating your license, 
please review the troubleshooting steps at the end of this publication.

eBUS SDK for Linux Quick Start Guide
This guide provides you with the steps to use the eBUS SDK on the Linux operating system, on a 
Linux x86_64, or ARM platform. This guide is intended for novice Linux users, although advanced 
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Linux users may be interested in some of the eBUS SDK-specific elements of this guide.

eBUS SDK .NET API Quick Start Guide
This guide provides you with instructions for compiling and using the sample code are provided, 
along with an overview of the basic calls that can be used to build custom applications using the 
eBUS SDK .NET API.

eBUS Player User Guide
This guide provides in-depth details about setting up and using the eBUS Player software application 
to control your GigE Vision or USB3 Vision compliant video transmitters (cameras) and receivers.

eBUS Player Quick Start Guide
This quick start guide provides you with the information you need to start using the eBUS Player 
application, which lets you control the parameters of your GigE Vision or USB3 Vision compliant 
device and lets you view imaging video and data. 

eBUS SDK Python API Quick Start Guide
This guide provides you with the information you need to install the eBUS SDK (which lets you use the 
eBUS SDK Python API) and an overview of the system requirements.

eBUS SDK on Raspberry PI 4/5 Quick Start Guide
This guide provides you with the steps to use the eBUS SDK on a Raspberry PI 4/5. This guide is 
intended for novice Raspberry PI 4/5 users, although advanced Raspberry PI 4/5 users may be 
interested in some of the eBUS SDK-specific elements of this guide.

Supported Software Ecosystem
This support summary provides an overview of the supported protocols, operating systems, ARM 
platforms, development environments, and drivers. Pleora is currently supporting eBUS SDK 5.0 and 
later. 
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2 About eBUS Player
eBUS Player is a sample application that allows you to control the parameters of GigE Vision and USB3 
Vision compliant devices by providing access to the GenICam-compliant XML files built into all GigE 
Vision and USB3 Vision compliant devices. The XML file provides access to the GigE Vision and USB3 
Vision device features, which are controlled with the GenICam API and a GenICam node map.

eBUS Player allows you to save GenICam XML information retrieved from a device; you can also load 
the saved GenICam XML file information to a device.

Not just a controller, eBUS Player also receives and allows you to view streaming data. While viewing 
the image data, you can use eBUS Player to balance the colors, and save video, images, and device 
configuration settings.

You can use the tools in eBUS Player to determine the optimal settings for your Vision system.

As you become more familiar with GigE Vision, USB3 Vision, and GenICam, you can continue to control 
your GigE Vision and USB3 Vision devices using eBUS Player, or you can build your own software 
application using the eBUS SDK.

2.1 Installing and Launching eBUS Player
The eBUS Player application is installed with the eBUS Player Toolkit (Windows operating system) or 
eBUS SDK (Windows and Linux operating systems).

2.1.1 Windows Operating System

Follow the installation wizard prompts to install the eBUS Player Toolkit (available for free download) or 
the eBUS SDK, which includes the eBUS Player (available for purchase from the Pleora Store).

You can launch eBUS Player from the Windows Start menu, under eBUS.

Please note that runtime packages are also available for the eBUS SDK, for easy integration into 
applications developed with the eBUS SDK.
The runtime packages install only the items that are required to run an application created with 
the eBUS SDK (including GigE Vision and USB3 Vision drivers). They exclude the items that are 
used to create applications with the eBUS SDK (such as header files, libraries, sample code, and 
API Help files).



 You can access the installation files from the Pleora Support Center at https://
supportcenter.pleora.com.
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2.1.2 Linux Operating System

Detailed instructions for installing and starting eBUS Player on the Linux operating system are provided 
in the eBUS SDK for Linux Quick Start Guide, available on the Pleora Support Center at https://
supportcenter.pleora.com.

2.1.3 System Requirements

Ensure the computer on which you install the eBUS Player Toolkit or eBUS SDK meets the following 
recommended requirements:

At least one Gigabit Ethernet NIC (if you are using GigE Vision devices) or at least one USB 3.0 port (if you are 
using USB3 Vision devices).

An appropriate compiler or integrated development environment (IDE):

Visual Studio 2019, 2017, 2015, 2013, 2012, and 2010.
Sample project files (.vcxproj) are compatible with Visual Studio 2012 (and later). When you open 
them with Visual Studio for the first time, you have the option of upgrading

One of the following operating systems:

For Microsoft Windows

Microsoft Windows 11, 64-bit

Microsoft Windows 10, 32-bit or 64-bit

Microsoft Windows 8.1, 32-bit or 64-bit

Microsoft Windows 7 with Service Pack 1 (or later), 32-bit or 64-bit
For the x86 Linux platform:

Ubuntu 22.04 LTS 64-bit: Qt 5.15.3

You can access installation files from the Pleora Support Center at supportcenter.pleora.com.

For supported USB 3.0 host controller chipsets, consult the eBUS SDK Release Notes, available 
on the Pleora Support Center.



 Depending on the incoming and outgoing bandwidth requirements, as well as the performance of 
each NIC, you may require multiple NICs. For example, even though Gigabit Ethernet is full duplex (that 
is, it manage 1 Gbps incoming and 1 Gbps outgoing), the computer’s PCIe bus may not have enough 
bandwidth to support this. This means that while your NIC can — in theory — accept four cameras at 
200 Mbps each incoming, and output a 750 Mbps stream on a single NIC, the NIC you choose may not 
support this level of performance.
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Ubuntu 20.04 LTS 64-bit: Qt 5.12.8

Ubuntu 18.04 LTS 64-bit Qt 5.9.5

RHEL 8.7, 64-bit: Qt 5.15.3

CentOS Stream 8, 64-bit: Qt 5.15.3
For the Linux for ARM platform:

NVIDIA Jetson TX2, Jetson Nano, Jetson Xavier NX, Jetson AGX Xavier, Jetson TX2 NX 
running JetPack 4.6 (Ubuntu 18.04)

NVIDIA Jetson AGX Xavier, Jetson Xavier NX, Jetson AGX Orin, Jetson Orin NX running 
Jetpack 5.1.x which x is between 0 and 3. (Ubuntu 20.04) 

Raspberry Pi 4 , Raspberry Pi 5 running Raspberry Pi OS (64 bits) (Debian aarch64 GNU/Linux 
12 bookworm) 

According to the Linux/ARM platform, we provide eBUS Python for the stock Python version of the OS:

Ubuntu 22.04 Desktop (64-bit), eBUS Python for Python 3.10 is installed with the SDK
Ubuntu 20.04 Desktop (64-bit), eBUS Python for Python 3.8 is installed with the SDK
Ubuntu 20.04 for ARM (64-bit), eBUS Python for Python 3.8 is installed with the SDK
Ubuntu 18.04 Desktop (64-bit), eBUS Python for Python 3.6 is installed with the SDK
Ubuntu 18.04 for ARM (64-bit), eBUS Python for Python 3.6 is installed with the SDK
RHEL 8 (64-bit), eBUS Python for Python 3.6 is installed with the SDK
CentOS 8 Stream (64-bit), eBUS Python for Python 3.6 is installed with the SDK
Raspberry Pi Desktop (64-bit), eBUS Python for Python 3.11 is installed with the SDK.

2.2 Working with eBUS Player
The main screen of eBUS Player consists of two main sections. You can select, connect to, and acquire 
images from your GigE Vision or USB3 Vision device using the functions in the Connection section on 
the left side of the main screen, and you can view video in the Display section on the right side of the 
main screen.


For non-default Python versions for different Linux ARM/x86 platforms, 
consult your Pleora support representative.

 Ensure that you uninstall any previous versions of eBUS SDK from your machine before 
installing eBUS SDK 6.x.
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2.3 GigE Vision and USB3 Vision Support
eBUS Player provides the flexibility to communicate with both GigE Vision devices and USB3 Vision 
devices. As you work with eBUS Player, you will notice that the available options in the user interface 
vary, depending on the type of device to which eBUS Player is connected.

eBUS Player can communicate with GigE Vision devices using either a direct Ethernet connection or 
through a GigE switch. For USB3 Vision devices, eBUS Player uses a direct USB 3.0 connection.

 For more detailed information about how to use eBUS Player to control your GigE Vision or USB3 
Vision devices, please see “Controlling GigE Vision and USB3 Vision Devices”
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3 Choosing a Driver
This chapter describes the drivers that are available, and provides guidance on selecting the driver that 
is best suited for your system.

3.1 Comparing Drivers
The eBUS Player Toolkit and eBUS SDK provide you with drivers you can install to:

Optimize the performance of your GigE Vision system
Connect to, control, and receive images from USB3 Vision devices

You can use the eBUS Driver Installation Tool to install or change drivers. The Driver Installation Tool 
can be launched from the Windows Start menu, under eBUS.

Table 1: Available Drivers

Driver Description

Manufacturer Driver Provides functionality developed by the card’s manufacturer.
For GigE Vision systems, you can use the default network stack on your computer 
or laptop when it is not desirable or possible for you to install a driver. The 
network stack offers acceptable performance in most scenarios, but applications 
will consume greater processor resources during operation, and throughput may 
be limited.
For USB3 Vision systems, if you are using a USB3 Vision device without installing 
the USB3 Vision driver, eBUS Player will detect a USB3 Vision device, but you 
cannot connect to the device, control the device, or stream images. To perform 
these activities, you must install the eBUS Universal Pro for USB3 Vision Driver.

Universal Pro for 
GigE Vision Driver

Provides the best performance and excellent compatibility with most network 
adapters. For use with GigE Vision devices.

Universal Pro for 
USB3 Vision Driver

Provides control and streaming capabilities. For use with USB3 Vision devices.

 Some USB 3.0 host controllers allow you to enable or disable power 
management. We recommend that you disable power management.
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3.2 Using the eBUS Driver Installation Tool
Included in the eBUS Player Toolkit and eBUS SDK is the eBUS Driver Installation Tool. You can use this 
tool to install or uninstall a Pleora driver.

To install a Pleora driver

On the Windows Start menu, click eBUS > eBUS Driver Installation Tool.

Under the driver that matches the types of devices you will connect to, click Install.
The USB3 Vision driver is installed across all USB3 Vision devices on your computer. The GigE Vision 
driver is installed across all network adapters on your computer. 
If you want to disable the driver for a particular network adapter, see “Configuring the Network 
Adapter”

Close the eBUS Driver Installation Tool. 
You may be required to restart your computer.

You can choose to install Pleora drivers as part of the eBUS SDK installation wizard, or you can 
use the eBUS Driver Installation Tool to install or uninstall a driver.



To see the versions of the installed drivers, click Help > About.
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3.3 Configuring the Network Adapter
For GigE Vision devices, you can configure your network adapter to reduce CPU utilization, and enhance 
receive and transmit performance.

In the eBUS Driver Installation Tool, click Advanced to configure your network adapter. In the Network 
Adapter Configuration dialog box that appears.

You can perform the following tasks for the selected network adapter:

Enable or disable the eBUS Universal Pro for Ethernet driver.
Enable or disable jumbo packets.
Change the number of receive and transmit buffers.
Open the Windows Device Manager to configure additional network adapter properties or to 
configure settings that are unavailable in this dialog box.
Open the Windows Internet Protocol version 4 Properties dialog box to configure the IP address 
and subnet.

The Network Adapter Configuration dialog box provides detailed descriptions of these settings 
and explains the impact of these settings on latency and memory consumption.



 As you adjust the settings the changes are applied to the selected network adapter.
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4 Configuring Firewalls to Allow Communication With GigE 
Vision Devices

Some third-party GigE Vision devices do not support the optional features introduced in version 1.1 (and 
later) of the GigE Vision standard, which ensure compatibility with firewalls. This restriction requires you 
to disable the computer firewall to properly use devices that do not support the optional features.

This chapter provides you with instructions for disabling the firewall in the Windows 8 and Windows 7 
operating systems. This chapter only applies to systems that include GigE Vision devices; it does not 
apply to systems that use USB3 Vision devices.

4.1 Pleora GigE Vision Devices Support Firewall Compatibility 
Features

Pleora GigE Vision devices support the firewall compatibility features introduced in version 1.1 (and 
later) of the GigE Vision standard. These features allow devices to report the device-side UDP ports they 
use for streaming and messaging channels. This reporting feature allows the SDK to know exactly 
where to send the packets that are used to keep the firewall open.

The eBUS SDK operates correctly with Windows firewalls when used with Pleora GigE Vision devices. 
You should not have to lower the firewall or take any specific action.

4.1.1 Third-Party Devices

Version 1.1 of the GigE Vision standard added optional features, allowing devices to report which 
device- side UDP port is used for streaming each available streaming channel, and for the messaging 
channel. This mechanism allows the eBUS SDK to know exactly where to send the packet that is used 
to keep the firewall open.

It is important to understand that this GigE Vision 1.1 feature is optional. Not all third-party devices 
support it, even if they report using GigE Vision 1.1 (or later).

If your third-party devices support the firewall compatibility features, your system should work without 
having to disable the firewall.

 It is important to note that in most cases, you do not need to disable the computer firewall.

 For more detailed information about how firewalls function, including how firewalls can affect GigE 
Vision devices, see the Pleora Technologies knowledge base article, Correcting Firewall Issues with 3rd 
Party GigE Vision Devices, available on the Pleora Support Center at https://supportcenter.pleora.com.
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If your third-party devices do not support the firewall compatibility features, the firewall needs to be de- 
activated for your system to stream, or use the messaging channel.

4.2 Disabling the Windows Firewall
This section provides you with the steps to take to disable the Windows firewall. You can control the 
firewall setting for domain networks (corporate), home or private networks (behind a secured router, 
such as a home or SOHO network), or a public network.

We recommend that you do not deactivate the firewall on a public network, such as a wireless access 
point at a coffee house or hotel. If you are on a corporate or home network, but Windows behaves as if 
you are on a public network, you might need to set the correct type of network used by your NIC.

To disable the Windows 11 firewall

On the Windows Search menu, search for Firewall.

Open Windows Defender Firewall.

Click Turn Windows Defender Firewall on or off.

For the given network type (Domain, Private or Public), select the Turn off Windows Defender Firewall 
(not recommended)

To disable the Windows 10 firewall

On the Windows Start menu, open Windows Defender Security Center.

Click Firewall & network protection.

Choose a network profile.

Under Windows Firewall, turn it off.

To disable the Windows 8 firewall

Open Windows Firewall by pointing to the upper-right corner of the screen, moving the mouse pointer 
down, and then clicking Search.

In the search box, type firewall.

Click Settings.

Click Windows Firewall.

 eBUS SDK 6.1 (and later) supports GigE Vision 2.1 (and earlier).

 If your device is connected to a network, network policy settings might prevent you from completing 
these steps. For more info, contact your administrator.
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In the left pane, click Turn Windows Firewall on or off. You might be asked for an admin password or 
to confirm your choice.

Click Turn off Windows Firewall (not recommended) for the appropriate network locations.

Click OK.

To set the network type for the Windows 7 firewall

Click Start > Control Panel.

Click Network and Internet.

Click Network and Sharing Center.

Adjust the network settings.

Close the Control Panel.

To disable the Windows 7 firewall

Click Start > Control Panel.

Click System and Security.

Click Windows Firewall.

In the Control Panel Home, click Turn Windows Firewall On or Off.

Select Turn Off Windows Firewall for the appropriate network locations.

Close the Control Panel.
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5 Controlling GigE Vision and USB3 Vision Devices
After you have assembled and powered up the GigE Vision and USB3 Vision devices in your video 
system, you can connect to and adjust the settings of the devices using eBUS Player.

5.1 Connecting to a Device
When you click Select/Connect on the main page of eBUS Player, eBUS Player automatically detects:

GigE Vision devices connected to your computer’s NIC(s) or switch
USB3 Vision devices connected to your computer’s USB port or hub

For GigE Vision devices, it is important for eBUS Player to be installed on a computer that is configured 
for the same subnet as the GigE Vision device to which you want to connect.

To connect to a device

On the Windows Start menu, click eBUS > eBUS Player.

Under Connection, click Select/Connect.

Click the GigE Vision or USB3 Vision device in the Available Devices list, and then click OK.

If you are using the manufacturer driver, a message may appear, indicating that you are not using an 
eBUS Keep in mind the following information about drivers:

GigE Vision devices. For optimal streaming performance, we recommend you use the GigE 
Vision driver.

USB3 Vision devices. The manufacturer driver allows eBUS Player to detect USB3 Vision 
devices, but you cannot control the devices or stream images. To perform these activities, you 
must install the USB3 Vision driver.
For more information, see “Choosing a Driver”
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If your GigE Vision device does not appear in the Available Devices list (possibly because 
eBUS Player and the GigE Vision device are not on the same subnet) you can do one of the 
following:

Click Show unreachable Network Devices.
If the IP address is not valid (that is, the device is on a different subnet than the 
computer running eBUS Player), a red warning icon appears. Click Set IP Address and enter a 
temporary IP address, subnet mask, and default gateway in the Set IP Address dialog box. 
Click OK to close the Set IP Address dialog box. Please note that this information is temporary 
and is reset when you power down the device. To enter an IP address that is permanently 
used on the GigE Vision device, see “To configure a persistent IP address for a GigE Vision 
device”.

If you know the IP address of the device, click Select from IP Address. In the Select From IP 
Address dialog box, type the IP address and then click OK. Please note that your device must 
be on the same subnet as the computer running eBUS Player.

Click OK in the Device Selection dialog box.

If you are connecting to a Camera Link external frame grabber, such as the CL-GigE, CL-U3, or CL-Ten 
External Frame Grabbers, you are asked how you plan to control the You can do one of the following:

If you are only interested in seeing the image stream and will configure camera control later, 
click I will manually configure how the camera is controlled.

If you already have a CL Protocol library on your computer, it will appear under I have a a CL 
Protocol library that can be used to control my camera. You can select this option to connect 
to the external frame grabber and control the camera.

If your camera is GenCP compliant, click My camera is GenCP compliant to connect to the 
external frame grabber and control the camera.
For more information about these options, see “Establishing Communication Between a 
Camera and Third-Party Camera Configuration Software”

If you are using the vDisplay HDI-Pro External Frame Grabber with your GigE Vision device, the first 
time you start eBUS Player and connect to a vDisplay HDI-Pro External Frame Grabber, the following 
message may Click Yes. 
Roles are discussed later in this guide, in “Configuring eBUS Player as a Controller or Data Receiver”

Now that you have connected to the device, here are some common tasks that you can perform:

Configure a persistent IP address for the device, which will persist across power cycles, as 
outlined in “Configuring a Persistent IP Address for a GigE Vision Device”

Acquire images to see the image stream or the Pleora test pattern, as outlined in “Acquiring 
Images”
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5.2 Configuring a Persistent IP Address for a GigE Vision Device
As specified by the GigE Vision standard, compliant devices are configured to automatically acquire an 
IP address using Dynamic Host Configuration Protocol (DHCP) or Link Local Addresses (LLA), provided 
no persistent IP address has been assigned. This allows you to immediately connect to the device at 
first-time deployment, and then, if you choose to, provide it with a persistent IP address. If you provide 
the device with a persistent IP address, it will use this persistent IP address each time it is powered up 
and connected to the network.

To configure a persistent IP address for a GigE Vision device

Start eBUS Player and click Select/Connect.

Click the device in the Available Devices list.

Click OK in the bottom right corner.

Under Parameters and Controls click Device control.

In the TransportLayerControl section of the Device Control dialog box, enter the expected persistent 
IP address and a subnet mask in the GevPersistentIPAddress and GevPersistentSubnetMask boxes, 
respectively.

Enter a default gateway in the GevPersistentDefaultGateway box.

 The device can use the persistent IP address each time it is powered up as long as the IP address is 
valid and there are no IP address conflicts.

 The subnet gateway value can remain at 0.0.0.0.
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Click True in the GevCurrentIPConfigurationPersistentIP list.

Enter the persistent IP address in the GevPersistentIPAddress box.

Close the Device Control dialog box.
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5.3 Acquiring Images
Because most devices start up in a state that is ready to send images, you can start acquiring images 
as soon as you apply power and connect the transmitter to the network (for GigE Vision devices) or USB 
3.0 port on your computer (for USB3 Vision devices with the USB3 Vision driver installed).

Pleora GigE Vision and USB3 Vision devices can transmit a test pattern, which is a test image generated 
by the device and can be used when a camera head is not available (most devices transmit a test 
pattern by default). If you have a camera head, you can turn the test pattern off to see the image 
stream.

To turn the test pattern on or off

Start eBUS Player and click Select/Connect.

Click the device in the Available Devices list.

Click OK in the bottom right corner.

Under Parameters and Controls, click Device control.

Under ImageFormatControl, click a test pattern option in the TestPattern (or TestImageSelector for 
some devices) list.

 The device uses the persistent IP address first, but if this option if set to False, it uses the IP 
address provided by DHCP next, and if this fails, uses LLA to find an available IP address. LLA 
cannot be disabled and is True by default.

 If you are using eBUS Player to connect to a vDisplay HDI-Pro External Frame Grabber, this section 
does not apply. A vDisplay HDI-Pro External Frame Grabber acts as a controller and/or receiver, which 
means that it does not transmit video over the network. Instead, skip this section and go to 
“Configuring eBUS Player as a Controller or Data Receiver”.
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Close the Device Control dialog box. 

To acquire images

Start eBUS Player and click Select/Connect.

Click the device in the Available Devices list.

Click OK in the bottom right corner. 

For multi-source GigE Vision devices, click the source to which a camera is connected under Source. 
If you do not have a camera connected, you can use the test For more information, see “To turn the 
test pattern on or off”.

In the Mode list, click Continuous, which configures the device to send a stream of continuous 
images (instead of a single image).

For other acquisition modes, see “Configuring How Images are Acquired”.

Click Play.
The images appear in the Display section.
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5.4 Adjusting Image Displays
eBUS Player provides you with tools to adjust your images.

To adjust the display frame rate

On the Tools menu, click Display and then click a display rate.

- Or -

Click Disabled to turn off the display of images. This can be useful when benchmarking the 
performance of the eBUS SDK.

To zoom the image in or out

Right-click the image and click a zoom setting.

To use RGB filtering to adjust the image color

On the Tools menu, click Image Filtering.

Some of the core GenICam commands are executed when you click buttons and make 
selections in the Player window. For example, when you click Play or Stop and you are 
working with a GigE Vision device, the AcquisitionStart and AcquisitionStop commands 
are executed. When you select a source for a multi- source GigE Vision device, the 
GevStreamChannelSelector feature is accessed.



We recommend that you do not use the AcquisitionStart and AcquisitionStop features in 
the Device Control dialog to start and stop streaming. Instead, you should use the Play
and Stop buttons in the Player window.


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Under RGB Filtering, select the Enabled check box.

Adjust the image color.
Gains are multipliers for all R, G, and/or B color values. Offsets are values that are added to all R, G, 
and/or B color values.
Clicking White Balance adjusts the gains so that the last acquired image is balanced to average gray. 
As you make adjustments, the image is updated in the Display section.

Close the dialog box when your adjustments are complete. 

To change Bayer interpolation to display images

On the Tools menu, click Image Filtering.

Under Bayer Interpolation, click an interpolation method to display images: Simple (2 x 2) or 
Interpolation (3 x 3).

Close the dialog box. 
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5.5 Reconstructing Images from a Multi-Tap Camera
For multi-tap cameras, pixels may not be received in order from the camera, depending on its tap 
geometry. Using the tap reconstruction option in eBUS Player, you can specify the tap geometry that 
corresponds to your camera, which allows the eBUS Player to reconstruct the image before it appears 
on your display and before it is saved in image or MP4 format.

To reconstruct the pixels from a multi-tap camera

On the Tools menu, click Image Filtering.

Under Tap Reconstruction, select a tap configuration.
The change is applied immediately and the image updates (if it is already playing in eBUS Player).

5.6 Using the Histogram Feature to Remap the Dynamic Range of 
Images and Video

For pixel formats that have more than 8 bits per component, the least significant bits (LSB) are not 
shown in the eBUS Player display. Depending on your image, this may make it difficult to see objects in 
the camera’s field of view clearly. You can use the histogram feature to remap the dynamic range of 

 Some Pleora devices, perform reconstruction for selected tap geometries, allowing the image to be 
reconstructed before it is transmitted. For more information, see the user guide that accompanies your 
Pleora device.

A variety of tap geometries can be reconstructed using eBUS Player. For descriptions of the tap 
geometries, see the GenICam Standard Features Naming Convention (SFNC), available from the 
European Machine Vision Association at http://www.emva.org/.


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images that are displayed in eBUS Player or exported as H.264 video. This can help make the image or 
video clearer.

The histogram shows the number of pixels with the pixel value and the range of colors.

By adjusting the Light and Dark sliders, you can constrain the pixel values used for display.

To remap the dynamic range of images displayed in eBUS Player or exported as H.264 video

On the Tools menu, click Image Filtering.

Under Histogram, select the Enabled check box.



eBUS Player User Guide

Doc ID: MN-0046 - Controlling GigE Vision and USB3 Vision Devices – 26

3.

•

•

Do one of the following:

Move the Dark and Light sliders to constrain the pixel values that are used for display.

Click the Auto Configure button to move the sliders to the lightest and darkest points on the 
histogram.

5.7 Displaying Chunk Data
You can choose to overlay chunk data as text on top of images in the Display section. Chunk data is 
often used to provide the status of external devices at the moment that the image was captured. The 
ability to overlay chunk data on images is available for devices that are compatible with version 2.0 (and 
later) of the GigE Vision standard or version 1.0 (and later) of the USB3 Vision standard.

To display chunk data

Examples of chunk data
In a quality inspection system where a rotary encoder (or shaft encoder) is used on a conveyor 
belt, chunk data can include the position of the conveyor belt at the moment that the image was 
captured or a count of position changes.
For systems that pre-process images, such as systems that perform edge detection, chunk data 
can include the result of the pre-processing operation (for example, chunk data can indicate 
where the edges are).



 To use this feature, your GigE Vision or USB3 Vision device must be configured for chunk data. For 
more information, see the documentation accompanying your device. For detailed information about 
the extended chunk mode feature, see the iPORT Advanced Features User Guide, available on the Pleora 
Support Center at https://supportcenter.pleora.com.
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On the Tools menu, click Display Chunk Data.
If the chunk data consists of printable characters, it is overlaid on top of the image. 
Chunk data is overlaid on top of the image in eBUS Player.

5.8 Saving Images and Video
eBUS Player allows you to save acquired images in image format (BMP, TIFF, PNG, raw binary format or 
Pleora Decompressed) or MP4 video format.

To save images and video periodically

On the Tools menu, click Save Images or Video.

Select the Enable Image or Video Saving check box.

Click the browse button to select a location to save image or video files, and then click OK.

In the Format list, click the format in which you want to save images:

Device independent bitmap (BMP)
This image format converted to RGB before saving.

Tagged Image File Format (TIFF),
This image format converted to Mono16 before saving.

Portable Network Graphics (PNG)
This image format converted to 8-bits/channel before saving.

 When saving H.264 video in an MP4 container on the Windows operating system, eBUS Player uses 
the Microsoft Media Foundation H.264 video encoder. The default video encoder settings are used, 
with the exception of the frame rate and average bit rate. The video is encoded at 30 frames per 
second. And the average bit rate is set to the value specified in the eBUS Player Image and Video 
Saving Options dialog box (see step 5 in the procedure below).

 When saving to TIFF format, 8-bit pixel types are saved as 8-bit TIFF monochrome 
images. 12, 14, and 16-bit monochrome images are saved as 16-bit TIFF monochrome 
images, and the data is normalized to 16-bit (the pixel data is shifted right of 6, 4, and 2, 
respectively) during conversion.

 All pixel formats in eBUS SDK are supported, however, they will be converted to 
either Mono8 or RGB8.
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Pleora Decompressed (BIN)
This image format decompressed to raw data before saving. This format should be use only 
when the incoming data payload is PTC compressed data. Otherwise, no image is saved.

H. 264 video in MP4 container:
Video format

If you selected H.264 video in MP4 container in step 4, specify the data rate of the video file in the 
Target encoding bitrate box.

Under Throttling options, specify when you want to save Images are saved in image format or MP4 
video format in the location specified in 3.

 Save one image out of every [ ] captured images.

Save a maximum of one image every [ ] ms. The display thread saves an image if at least X 
ms has elapsed since the last image was saved.

Throttle throughput to HDD. Maintain [ ] Mbits/s average. The throughput of saved images is 
monitored to stay as close to X Mbits/s as possible.

No throttling (Limited by CPU, HDD, Images may be dropped). The display thread attempts to 
save every image.

•

•

If you changed any of the options in the Image Filtering dialog box (Tools > Image 
Filtering), please note the following:

TIFF, PNG, Pleora Decompressed or raw binary. The image filtering 
configuration is not used for the image files that you save. Images are saved 
without any modification, which is beneficial if you are performing image 
processing.

BMP or MP4 video The image filtering configuration is used for video that 
you save, which can provide greater clarity.
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Click OK.
The Display section changes to red, the word RECORDING appears, and statistics about the recording 
appear, including the image count, the size of the file, the frame rate, and the data rate.
The file name of the saved image or video files contains the image index and the image timestamp. 
The timestamp reflects the number of milliseconds that have elapsed since the computer was 
started. The raw binary data format also includes the width, height, pixel format, and tap geometry (if 
applicable) of the image. This information is used by the eBUS Raw Image Viewer application to 
display raw binary data images properly. For more information about the eBUS Raw Image Viewer, 
see the Using the eBUS Raw Image Viewer Application to View Raw Binary Images knowledge base 
article at https://supportcenter.pleora.com.

To save the current image

On the Tools menu, click Save Current Image.
By default, the image is saved as a bitmap file in your Pictures library. To change the file type or 
location, see “To change the location and format in which the current image is saved”, below.
Please note that Save Current Image saves BMP, TIFF, or raw binary data, not MP4 video.

To change the location and format in which the current image is saved

On the Tools menu, click Save Images or Video.

Select the Enable Image Saving check box.

Click the browse button to select a location to save images, and then click OK.

In the Format list, click the format in which you want to save images:

Device Independent bitmap (BMP)

Tagged Image File Format (TIFF)

Portable Network Graphics (PNG)

Raw binary data

Pleora Decompressed (BIN)

You do not need to change the Throttling options, as only a single image will be saved.

Click OK.

 If you are displaying chunk data, only the image is saved (because the chunk data is overlaid on top 
of the image, it is not part of the image or video).

If you are saving images in MP4 format and have selected the Save one image out of every [ ] 
captured images, stopping recording before the entire image has been stored in the file will 
result in an incomplete MP4 file that cannot be played.


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5.9 Configuring How Images are Acquired
Depending on the device you use, eBUS Player provides you with a list of image acquisition modes. The 
modes allow you to acquire images continuously or frame-by-frame. You can also save images to the 
device’s onboard memory so that you can retrieve them later.

5.9.1 Modes Standard on Most GigE Vision and USB3 Vision Compliant Devices

Continuous, SingleFrame, and MultiFrame modes are usually standard for devices. Acquisition starts 
when the Play button is pressed (the AcquisitionStart command is executed).

Continuous Mode

This mode allows you to acquire images continuously and is the default mode for most devices.

SingleFrame Mode

This mode allows you to acquire a single image.

MultiFrame Mode

This mode allows you to acquire a fixed number of images. To configure the number of images, set the 
device’s AcquisitionControl > AcquisitionFrameCount feature.

You can set the AcquisitionControl > AcquisitionFrameCount feature in the Device Control dialog box, 
as shown in the following image.

 When you close and re-open eBUS Player, the default image format and save folder are used.

 The acquisition modes supported by a device are enumerated by the GenApi AcquisitionMode
feature.
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5.9.2 Recording and Readout Modes, Available on Pleora Devices

The recording acquisition modes allow you to capture images from a camera and store them in the 
Pleora device’s onboard memory. The readout acquisition modes allow images to be acquired from the 
device’s memory at a slower rate, ensuring images are not lost.

These modes are helpful when you are working with a camera that transmits images at a rate that 
exceeds the connection between the Pleora device and the computer, resulting in dropped images. By 
using the recording and readout modes, you can capture and stream images from the camera without 
losing any images (as long as there is space in the onboard memory).

The recording acquisition modes (ContinuousRecording, MultiFrameRecording, and 
SingleFrameRecording) support back-to-back recording, which allows you to click the Stop and Play 
buttons multiple consecutive times without clearing the onboard memory.

Acquisition starts when the Play button is pressed (the AcquisitionStart command is executed) when 
one of the recording modes is selected.

For more information about how many images can be stored in the Pleroa device’s onboard memory 
and to understand when images will be removed, see the user guide that accompanies the Pleora 
external frame grabber or embedded video interface. User guides are available on the Pleora Support 
Center at https://supportcenter.pleora.com.

5.10 Reviewing the Acquisition Status
During image acquisition, information about the stream appears under the image, in addition to any 
errors or warnings that have occurred.

In most cases, errors will not appear if you are connecting to a device for the first time. If an error 
appears, click Image stream control and review the information in the Counters section. If anything 
other than zero appears in the features within this section and you are using a GigE Vision device, 
consult the Stream Control Technical Note, available at the Pleora Support Center, to determine which 
feature is causing the error and for guidance on how to correct the error.
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5.11 Configuring eBUS Player as a Controller or Data Receiver
Depending on your system, you may need to configure the eBUS Player role, which lets you specify 
whether you want to use eBUS Player to control a GigE Vision or USB3 Vision device, or receive images, 
or simply connect to a device to view its parameters and settings. The following roles are available:

Table 2: Roles

Role Description

Controller and Data Receiver Select this role if you are using eBUS Player to connect to and 
control a GigE Vision or USB3 Vision transmitter AND if you 
want eBUS Player to receive streaming video from the 
transmitter.
This setting is ideal when you want to control an iPORT device 
and see streaming video with eBUS Player. This is the default 
setting.

Controller Select this role if you are using eBUS Player to connect to and 
control a GigE Vision or USB3 Vision device. eBUS Player does 
not receive streaming video from the device if this option is 
selected.
This setting is often used to connect eBUS Player to a receiver, 
such as the Pleora vDisplay HDI-Pro External Frame Grabber 
(for use with GigE Vision devices).

Data Receiver Select this role if you are using eBUS Player to connect to and 
receive streaming video from a GigE Vision or USB3 Vision 
device. You cannot control the device if this option is selected.

To configure eBUS Player as a controller or data receiver

Start eBUS Player and select Setup on the Tools menu.

Select a role.

For multi-channel GigE Vision devices, select the default channel under Stream Channel.

The vDisplay HDI-Pro External Frame Grabber receives video from the GigE Vision network and 
makes it available for display on an attached monitor.


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4. Click OK.

5.12 Configuring the Stream Destination for GigE Vision Devices: 
Unicast or Multicast

You can configure a GigE Vision stream destination to send images to a single location or to multiple 
locations.

Table 3: GigE Vision Stream Destination Options

Option Description

Unicast, automatic Select this option to configure the camera to stream video 
directly to the eBUS Player computer using an automatically-
selected port.

Unicast, specific local port Select this option to configure the camera to stream video 
directly to a user-defined port on the eBUS Player computer.

For multi-channel GigE Vision devices, eBUS Player queries the GenICam interface of the 
device (in most cases) to determine which channel should be used with the source. In 
cases where eBUS Player cannot determine the channel to use, the default channel that 
you specify is used. This can occur when you are using a data receiver that does not have 
access to device control. If you are multicasting and want to set up a pure data receiver, 
you need to specify the channel on which to listen by typing the Default channel.



If eBUS Player is already connected to a device, you must close the Setup dialog box and 
disconnect from the device before you can select an eBUS Player role.


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Unicast, other destination Select this option to configure the camera to stream video 
directly to a computer or a vDisplay External Frame Grabber (a 
destination other than the eBUS Player computer).

Multicast Select this option to configure the camera to join a multicast 
group (specified by the IP address and port), and to begin 
streaming to that group.
The vDisplay External Frame Grabber or any other receiver 
(such as a computer), must be configured to receive 
streaming video at the same multicast address.
If eBUS Player is configured as a multicast receiver, it allows 
you to view video from the camera streaming video to the 
same multicast address.

5.13 Accessing the Communication Settings
You can access the communication settings to adjust how the host computer connects to, and 
communicates with, GigE Vision or USB3 Vision devices.

Before you connect to a GigE Vision or USB3 Vision device, you can set the default communication 
parameters that will be used for the connection. If the connection is already established, you can adjust 
the communication settings as required.

To set the default communication parameters for the initial device connection

Start eBUS Player.

On the Tools menu, click Default GigE Vision Communication Parameters or Default USB3 Vision 
Communication Parameters.

The Default GigE Vision Communication Parameters or Default USB3 Vision Communication 
Parameters dialog box appears.

Customize the communication settings as required and then close the dialog box.
When you connect to the GigE Vision or USB3 Vision device, the communication settings that you 
specified will be used. For information about connecting to a device, see “To connect to a device"

To change the communication settings

Start eBUS Player and click Select/Connect.
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Click the GigE Vision or USB3 Vision device in the Available Devices list.

Click OK in the bottom right corner.

Under Parameters and Controls, click Communication control.

The Communication Control dialog box Customize the communication settings as required by 
adjusting the features in the dialog box.

5.14 Accessing the Device Settings
To change the device settings, you can access the eBUS Player Device Control dialog box. This dialog 
box lets you specify the settings related to your device, including transport layer settings, image 
processing settings, image mode and formatting settings, display timing settings, channel settings, 
autonomous control settings, and messaging settings.

 The Communication control button is only available when eBUS Player is connected to a device. To 
configure the communication settings before a connection is established with a GigE Vision or USB3 
Vision device, see “To set the default communication parameters for the initial device connection”
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By changing the values of controls in the eBUS Player control dialog boxes, you can change how the 
GigE Vision or USB3 Vision device (and connection between the device and the host computer) 
performs.

System configuration is comprised of the following three categories, and provides a set of controls for 
each category in a separate dialog box:

Communication Control dialog Controls connection and communication settings between the host 
computer and the GigE Vision or USB3 Vision device. For information about the communication 
settings, see “Accessing the Communication Settings".
Device Control dialog Controls all device settings, including transport layer settings, image 
processing settings, image mode and formatting settings, display timing settings, channel settings, 
autonomous control settings, and messaging settings.
Image Stream Control dialog Controls image stream settings and provides performance statistics.

5.14.1 Connection Section

The following table shows the relationship between the controls in the Device Control dialog box and 
the controls in the Connection section.

Table 4: Connection Section Controls and Features

Connection section control Corresponding feature

IP address field (GigE Vision devices only) Device Control dialog box > TransportLayerControl / 
GevCurrentIPAddress

 We recommend that you do not use the AcquisitionStart and AcquisitionStop features in the Device 
Control dialog to start and stop streaming. Instead, you should use the Play and Stop buttons in the 
Player window.

While the available communication control and stream control features do not change based on 
device, the available device control features are retrieved from the device’s XML file. The device 
control features will vary depending on the device you are working with.



To help you locate features in the Communication Control, Device Control, and Image Stream 
Control dialog boxes, you can use the search box. By default the search box is hidden. To make it 
available, open any of these dialog boxes (ensuring the dialog box has focus) and press CTRL + 
F.


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MAC address field (GigE Vision devices only) Device Control dialog box > TransportLayerControl / 
GevMACAddress

GUID field (USB3 Vision devices only) Communication Control dialog box > Connection / 
DeviceGUID (not shown below)

Vendor field Device Control dialog box > DeviceControl / 
DeviceVendorName (not shown below)

Model field Device Control dialog box > DeviceControl / 
DeviceModelName (not shown below)

5.14.2 Acquisition Control Section

The following table shows the relationship between the controls in the Device Control dialog box and 
the controls in the Acquisition Control section.

Table 5: Acquisition Control Section Controls and Features

Acquisition Control section control Feature in the Device Control dialog box

Source list (for multi-source GigE Vision devices) TransportLayerControl / GevStreamChannelSelector



eBUS Player User Guide

Doc ID: MN-0046 - Controlling GigE Vision and USB3 Vision Devices – 38

Mode list AcquisitionControl / AcquisitionMode

Play button AcquisitionControl / AcquisitionStart (GigE Vision 
devices only)

Stop button AcquisitionControl / AcquisitionStop (GigE Vision 
devices only)

5.14.3 Display Section

The following table shows the relationship between the information in the Device Control dialog box and 
the controls in the Display section.

 If you use the AcquisitionStart and AcquisitionStop features in the Device Control dialog box to 
start and stop streaming from a GigE Vision device, please note that the TLParamsLocked feature is 
not activated, allowing you to change features that are normally locked during image streaming, such 
as width and height. This may cause unexpected results. Whenever possible, we recommend that you 
use the Play and Stop buttons to start and stop streaming.
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Table 6: Display Section Controls and Features

Display section information Feature in the Image Stream Control dialog box

Image count (nnn images) Statistics / General / BlockCount

Frame rate (xxx FPS) Statistics / General / AcquisitionRateAverage

Data rate (yyy Mbps) Statistics / General / BandwidthAverage

For transmitters that do not timestamp packets, an asterisk (*) appears next to the frame rate (FPS) 
and data rate (Mbps) in the Display section, which indicates that host-side timestamps values were 
used to calculate the frame and data rates. You can set the SDK to use the receiving computer’s time to 
do the calculation by clicking Image Stream Control and setting the Statistics > 
General >TimestampSourcePreferred feature to Software.

To change the device settings

Start eBUS Player and click Select/Connect.
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Click a GigE Vision or USB3 Vision device in the Available Devices list.

Click OK in the bottom right corner.

Under Parameters and Controls, click Device control.

The Device Control dialog box appears. Customize the settings as required by adjusting the features 
in the dialog box.

 Features that are light blue are dependent on features that are dark blue (selectors) in eBUS 
Player. For example, the UserSetLoad feature depends on the option that is selected in the 
UserSetSelector. If Default is selected, the default User Set is loaded when this command is 
executed. If UserSet1 is selected, User Set 1 is loaded.
Please note that depending on the feature order in the GenICam XML file (and sometimes 
depending on the GenICam Standard Feature Naming Convention requirements), the features 
that are light blue may not fall directly under the dark blue features (selectors).
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•

To adjust the display of features

Use the options listed in the following table when working with features.

 For eBUS Player on Windows, to access the Search functionality, you must press Ctrl+F 
when the Device Control dialog is open. For eBUS Player on Linux, this functionality is exposed 
by default.
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Table 7: Adjusting the Display of Features

Adjustment tool Description

Expand All button Expands the categories (when the Tree view is selected in the 
Browser Options dialog box).

Collapse All button Collapses the categories (when the Tree view is selected in the 
Browser Options dialog box).

Search box Performs a keyword search. Press CTRL + F to make the search 
box appear in the dialog box. Search results are highlighted in the 
dialog box. To move through the results, use the arrow buttons 
beside the search box.

Visibility list Filters the list of features to suit your level of video network 
responsibility and understanding. There are more controls 
available for the Guru level than the Beginner level; some controls 
are not available in the Beginner level.
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Browser Options button Opens the Browser Options dialog box, which allows you to:
•       Choose whether the features are displayed as an 
alphabetical list or a feature tree.
•       Show the features using either the feature name or the 
display name.
•       Specify whether the device features are refreshed 
automatically, based on polling time (as defined in the GenApi 
XML file that was used to build the node map), or manually 
refreshed (using the Refresh button).

Refresh button Refreshes the features of a GigE Vision or USB3 Vision device 
(such as a transmitter or receiver) that are displayed in the Device 
Control dialog box. The following refresh options are available in 
the Browser Options dialog box:
•       Polling. Features that are defined for polling are 
automatically refreshed (if the polling time configured for the 
feature has elapsed).
•       Automatic. The features are automatically refreshed every 
few seconds. This is the default setting.
•       Manual. You can manually refresh the features in the Device 
Control dialog box.

Minus button Collapses a category (when the Tree view is selected in the 
Browser Options dialog box).

Plus button Expands a category (when the Tree view is selected in the 
Browser Options dialog box).

5.15 Monitoring Performance
As your device receives images from your camera and sends them to your computer, it keeps track of 
image errors (such as missing lines), network errors (such as lost packets), and other performance-
related statistics.

You can view a complete list of error counts in the Image Stream Control dialog box. Performance 
metrics are grouped under Statistics.
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You can view a summarized list of error counts at the bottom of the Display section. The Display 
section shows the total number of images displayed (BlockCount), the instantaneous frame rate 
(AcquisitionRateAverage), and the data rate (BandwidthAverage).

For transmitters that do not timestamp packets, an asterisk (*) appears next to the frame rate (FPS) 
and data rate (Mbps) in the Display section, to indicate that these values are not available. In this case, 
the SDK uses the receiving computer’s time to calculate the values. You can change this behavior by 
clicking Image Stream Control and changing the Statistics > General >TimeStampSourcePreferred 
feature.
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5.16 Using the Event Monitor
The Event Monitor is a valuable tool that you can use to determine causes of issues that may occur 
during the use of your device. When enabled, you can view time-stamped records of all GenICam 
parameter updates and PvStream buffer errors, as well as the successful PvStream buffers.

You can clear the log content, and you can save the content to your hard drive.

To access the Event Monitor

Start eBUS Player and connect to the device.

Click Play.

On the Tools menu, click Event Monitor.

Select the information that you want to display in the Event Monitor:

GenICam parameter Reports all device GenICam parameter invalidation events (as triggered 
by GenApi) as event monitor log events.

Messaging channel Reports all GigE Vision or USB3 Vision events to the Event Monitor before 
they are raised as GenICam parameter invalidation events. Please note that a large number of 
events will appear.

Buffer Reports all buffers retrieved from the PvPipeline by the application display thread that 
have an operation result other than OK.

All buffer Reports all buffers retrieved from the PvPipeline by the application display thread, 
regardless of the operation result. Please note that a large number of events will appear.

Chunk Reports chunk data (when chunk data is enabled).

eBUS SDK log events. Reports interactions between the eBUS SDK (including eBUS Player) 
and the For example, when you start or stop a stream you will see a log event.

Device serial Echos all serial communication. For example, requests for parameter values and 
data that is sent through the Device Serial Communication dialog box.

To save events in the monitor
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• In the Event Monitor, select the Save to file check box and browse to the desired location.
Future events will be saved to a file on your computer.

5.17 Using the Device Serial Ports
If you have a thorough understanding of the serial protocol to be used, you can communicate with a 
camera or other external devices through serial ports connected to your Pleora device.

eBUS Player allows you to control the serial ports of a GigE Vision or USB3 Vision device that is 
integrated with a Pleora device. You can also transfer files to the device using the serial port, such as a 
Non-Uniformity Correction (NUC) file, a Look-Up Table (LUT), or camera firmware.

5.17.1 Configuring the Serial Ports

The controls to configure the serial ports are available in the Device Control dialog box, as shown in the 
following image.

5.17.2 Setting the Baud Rate for Serial Ports

You must set the baud rate for the serial ports if the default value is not acceptable.

To set the baud rate for serial ports

The available serial ports vary, depending on the device you are using.
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2.

3.

4.
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•

•

Start eBUS Player and connect to your camera.

Click the Device control button to open the Device Control dialog box.

Scroll to the IP Engine > PortCommunication Ensure you are using the Guru visibility level.

Depending on the type of device you are controlling, do one of the following:

In the Uart0 section, set the baud rate using the Uart0BaudRate control.

In the Uart1 section, set the baud rate using the Uart1BaudRate control.

In the PortCommunication section, use the BulkBaudRate control to set the baud rate. 

The baud rate can also be set in the Device Serial Communication dialog box that is described 
later in this section.


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1.

To communicate with a camera or other external device using a serial port

Start eBUS Player and connect to your camera.

Other settings, such as parity and the number of stop bits, should also be configured by entering 
the appropriate values for the settings in the PortCommunication section.


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2.

3.

4.

On the Tools menu, click Device Serial Communication.

In the Port Selection list, click a serial or bulk port, depending on your device.

In the Speed list, select the baud rate that matches your GigE Vision or USB3 Vision Additional 
settings, such as parity and the number of stop bits can also be configured. For more information, 
see “Configuring the Serial Ports”.
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5.

6.

7.

8.

9.

10.

1.

2.

3.

4.

5.

6.

Under Send as, click either ASCII (text only) or Hexadecimal to select the data transmission 
sequence format.

In the Data box, type the data string.
For hexadecimal, enter a pair of hexadecimal digits for each byte, separated by spaces. For example, 
01 23 45 67 89 AB CD EF.

Select one of the trailer options that appears beside Append.
Trailer options are not mutually exclusive; they append in the order shown.
Select Other for ASCII and hexadecimal sequences in custom trailers for devices that do not use the 
trailer options in the order shown, for example, CR and LF.

Click Send to transmit the data sequence.

Wait for the device to reply.

Close the Device Serial Communication dialog box.

To transfer a file to a device using a serial port

Start eBUS Player and connect to your camera.

On the Tools menu, click Device Serial Communication.

In the Speed list, select the baud rate that matches your GigE Vision or USB3 Vision Additional 
settings, such as parity and the number of stop bits can also be configured. For more information, 
see “Configuring the Serial Ports”.

Click the browse button that appears beside Send file, and click the file that you want to upload to the 
device.

Click Open.

For validation that the file was uploaded, select the Loopback validation check box.
For loopback validation to work, you must enable loopback mode for the serial port.
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•

Click Send file.

The content of the files being transferred appears under Transcript. When the transfer is complete, a 
brief message appears at the end of the transmitted content in the Transcript section.

5.17.3 Establishing Communication Between a Camera and Third- Party Camera 
Configuration Software

In some systems, you may be required to use an existing third-party camera configuration application 
(for example, the software application that was provided with the camera), a third-party application 
relying on a Camera Link DLL, or a Camera Link camera that has a CLProtocol DLL. In each of these 
cases, the system requires that applications send serial commands to a camera through a Pleora video 
interface, such as an embedded video interface or external frame grabber. Pleora’s eBUS Player (and 
eBUS SDK) contain functionality that allows you to establish a bridge to facilitate communication 
between eBUS Player and a camera.

For information about establishing a communication bridge, see one of the following knowledge base 
articles on the Pleora Support Center https://supportcenter.pleora.com.

Knowledge Base Article: Establishing a Serial Bridge through Camera Link DLL Communication. This 
article is for users who have a third-party camera configuration application that requires them to use 
a Camera Link DLL to send serial commands to the camera.
Knowledge Base Article: Establishing a Serial Bridge through a Serial Port (COM Port) Link. This article 
is for users who have a third-party camera configuration application and want to use a serial port on 
their computer to send serial commands to the camera, or would like to use a joystick connected to a 
serial port on their computer to control the camera.

 If the device does not send loopback data back to the computer as quickly as it is 
transmitted, congestion may occur in the serial FIFO, which can affect loopback performance.
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Knowledge Base Article: Establishing a Camera Bridge with a CLProtocol DLL and GenICam
CLProtocol1. This article is for users who have a CLProtocol DLL (provided by the camera 
manufacturer) that allows them to configure and monitor settings within the camera using GenCam.
Knowledge Base Article: Establishing a Camera Bridge through GenCP. This article is for users with a 
camera that supports the GenCP device control protocol.

https://supportcenter.pleora.com/s/article/Establishing-a-Camera-Bridge-with-a-CLProtocol-DLL-and-GenICam-CLProtocol-KBase
https://supportcenter.pleora.com/s/article/Establishing-a-Camera-Bridge-with-a-CLProtocol-DLL-and-GenICam-CLProtocol-KBase
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1.

2.

1.

2.

6 Saving eBUS Player and Device Settings
There are several options to save eBUS Player and device settings:

Save current session settings to a configuration file. Save the eBUS Player preferences and device 
settings to a configuration file, which you can use to start a new session or load during future 
sessions.
eBUS Player preferences only. Save the eBUS Player preferences, such as the frame rate used to 
display video in eBUS Player, as your default eBUS Player settings. This method also saves the 
Communication control settings, which are used to communicate with your device, such as a specific 
default heartbeat interval and answer timeout value.
Device settings. Save the settings to the device’s flash memory as a User Set, allowing the device 
settings to persist over power cycles.

6.1 Saving Your eBUS Player and Device Settings to a Configuration 
File

If you want to save the eBUS Player and device settings for a particular device, you can create a 
configuration file, which you can load during future sessions.

When you save your settings to a configuration file, all of the eBUS Player preferences, Communication 
Control settings, Image Stream Control settings, and device settings (for the particular device) are 
saved.

To save your eBUS Player and device settings to a configuration file

On the File menu, click Save.

Select the location in which you want to save the configuration file.

To load eBUS Player and device configuration settings from a configuration file

On the File menu, click Open.

Select the configuration file that you want to open.

If eBUS Player is not connected to a GigE Vision or USB3 Vision device, eBUS Player opens the file and 
attempts to connect to the device from which the configuration file was created. Please note, eBUS Player 
attempts to establish a connection based on the MAC address or USB 3.0 GUID of the device. For GigE 
Vision devices, using the MAC address (instead of the IP address) allows eBUS Player to connect to the 
device even if its IP address has changed.

A supplementary document is available on the Pleora Support Center that lists the settings that 
are saved with each of the options listed in this chapter. 
For more information, see "Saving eBUS Player and Device Settings".


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If eBUS Player is connected to a GigE Vision or USB3 Vision device, a message appears to warn you that the 
settings will be applied to the device. Click Yes to apply the settings that are stored in the configuration file, 
or No to cancel the operation (and then disconnect from the device and connect to a different device).

6.2 Saving Your eBUS Player Preferences
eBUS Player allows you to save the eBUS Player preferences as your default eBUS Player settings. This 
feature is useful when you prefer certain settings, for example, you like to use a high frame rate to 
display video in eBUS Player. It is also useful if you use Communication control settings to 
communicate with your GigE Vision or USB3 Vision devices, such as a specific heartbeat interval and 
answer timeout value.

If you want to revert back to the original eBUS Player default preferences, you can do so at any time.

To save your eBUS Player preferences

On the eBUS Player Tools menu, click Save Preferences.

The eBUS Player preferences, including the Communication control options, are saved.

6.3 Saving Your Device Configuration Settings to the Device’s Flash 
Memory

The changes that you make to your device are temporary and will not be persisted across power cycles. 
To save the changes to the device, you can use the options available in the UserSetControl section of 
the Device Control dialog box. Once saved, the changes (saved as “User Sets”) can persist across 
power cycles.

Most iPORT devices support two User Sets: UserSet1, which consists of the user-configured settings, 
and Default, which consists of the pre-configured settings, to which you can always revert. Settings 
identified as Default in the Device Control dialog box cannot be changed.

The following table describes the options available in UserSetControl.

Table 8: Saving Configuration Settings to a GigE Vision or USB3 Vision Device

 The Device control settings and the Image stream control settings are not saved when you click 
Save Preferences. The Device control settings can be saved as part of the device “user sets”. For more 
information, see “Saving Your Device Configuration Settings to the Device’s Flash Memory”. If the 
Image stream control settings do not meet your needs, you must configure them every time you 
connect to a device.

You can revert back to the original eBUS Player default preferences by clicking Restore Default 
Preferences on the Tools menu.


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Setting Description

UserSetSelector Selects the User Set to load or save.

UserSetLoad Loads the User Set specified by UserSetSelector to the device 
and makes it active.

UserSetSave Saves configuration data to the User Set specified by 
UserSetSelector, which is part of the non-volatile memory of the 
device.

UserSetDefaultSelector Selects the User Set to load and make active when the device is 
reset.

UserSetLoadLastUserSet Shows the last User Set executed by the device from a 
UserSetLoad
command, or as a result of a reset of the device.

UserSetLoadStatus Indicates the success or failure of the last User Set applied. The 
User Set can be applied through a power cycle or through user 
selection.

To save a configuration change to UserSet1

In the Device Control dialog box, make the required configuration changes.

Scroll to the UserSetControl section and change the UserSetSelector setting to UserSet1.

Click UserSetSave.

To load the default configuration settings (one-time)

In the UserSetControl section of the Device Control dialog box, select Default in the UserSetSelector
box.

Click the UserSetLoad setting and then click the UserSetLoad button that appears to the right.
The default settings are applied to the GigE Vision or USB3 Vision device.

To specify the persistent settings that are loaded every time the device is reset

In the UserSetControl section of the Device Control dialog box, select a User Set in 
the UserSetDefaultSelector box and then close the Device Control dialog box.
The next time the GigE Vision or USB3 Vision device is reset, the User Set that you selected is loaded.
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Technical Support
On the Pleora Support Center, you can:

Download the latest software and firmware.
Log a support issue.
View documentation for current and past releases.
Browse for solutions to problems other customers have encountered.
Read knowledge base articles for information about common tasks.

To visit the Pleora Support Center:

Go to supportcenter.pleora.com.

Most material is available without logging in to a Support Center account.
To access software and firmware downloads, in addition to other content, log in to the Support 
Center.
If you do not have an account, click Request Account.
Accounts are usually validated within one business day.
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